
Completing the OGE Form-1353

Saving the Workbook
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Preparing Blank Report Forms for Each Sub-Agency  (if applicable)
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Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.
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Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 6 2018

Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert Arzola Presenstation and 
Training on HABS 8/24/2018 Tuskegee, AL Air Transportation X $505 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $360 

HABS Architect M.J. Kaplan Fund 8/28/2018 8/24/2018-8/28/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Scott Bentley
Cultural Training and 
Meeting with Tribal 
Nations

9/4/2018 Wyandotte, OK Hotel X $295 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Superintendent Wyandotte Nation 9/8/2018 9/03/2018-9/08/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Rudy D'Alessandro
Study Tour for Chinese 
Planning and Park 
Government Officials

8/30/2018 Anchorage, AK Air Transportation X $1,437 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging and 
M&IE X $3,203 

International 
Cooperation Specialist Paulson Institute 9/16/2018 8/30/2018-9/16/2018                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Department of Interior
National Park Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

caitlin_rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

M.J. Kaplan Fund

BENEFIT SOURCE

Wyandotte Nation

BENEFIT SOURCE

Paulson Institute

BENEFIT SOURCE
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Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period
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Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP
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SIGAR
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OPIC
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RRB
RAT BOARD
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SBA
SSA
SIGIR
STB
TVA
PCB
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ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 6 2018

Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert Arzola Presenstation and 
Training on HABS 8/24/2018 Tuskegee, AL Air Transportation X $505 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $360 

HABS Architect M.J. Kaplan Fund 8/28/2018 8/24/2018-8/28/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Scott Bentley
Cultural Training and 
Meeting with Tribal 
Nations

9/4/2018 Wyandotte, OK Hotel X $295 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Superintendent Wyandotte Nation 9/8/2018 9/03/2018-9/08/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Rudy D'Alessandro
Study Tour for Chinese 
Planning and Park 
Government Officials

8/30/2018 Anchorage, AK Air Transportation X $1,437 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging and 
M&IE X $3,203 

International 
Cooperation Specialist Paulson Institute 9/16/2018 8/30/2018-9/16/2018                            

BENEFIT SOURCE

M.J. Kaplan Fund

BENEFIT SOURCE

Wyandotte Nation

BENEFIT SOURCE

Paulson Institute

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

caitlin_rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Department of Interior
National Park Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2 6 2018

Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Brooke Wheellock Earth Day 4/21/2018 Austin, TX Hotel X $194.54 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Park Ranger NPCA 4/21/2018 4/20/2018-04/22/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Anna Martinez-Amos Earth Day 4/21/2018 Austin, TX Lodging x $125.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $25.00 

Park Ranger Huston Tillotson 
University 4/21/2018 04/20/2018-

04/21/2018 Parking X $15.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Christopher Bentley Spanish Immersion 
Training 5/20/2018 Mexico Tuition X $400.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging & Meals X $455.00 

Supervisory Park 
Ranger NPF 6/7/2018 05/20/2018-

06/07/2018 Airfare X $570.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Department of the Interior
National Park Service / IMR

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

Caitlin_Rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

NPCA

BENEFIT SOURCE

NPCA

BENEFIT SOURCE

NPF

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

3 6 2018

Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Patricia Owen Bear Necessities Bear 
Rescue Event 9/23/2018 Gatlinburg, TN Air Transportation X $1,000 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $300 

Wildlife Biologist Appalachian Bear Rescue 9/23/2018 09/21/2018 -
09/25/2018 Meals x $50.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Grant Crosby

National Fire Protection 
Association (NFPA) 
Annual Committee 
Meeting

5/8/2018 Washington, DC Air Transportation X $572.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $439.68 

Supervisory Architect NFPA 5/9/2018 05/07/2018 - 
05/10/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

BENEFIT SOURCE

Appalachian Bear 
Rescue

BENEFIT SOURCE

NFPA

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

caitlin_rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

National Park Service
Alaska Region

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

4 6 2018

Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Emily Murphy Museum Exhibit 6/4/2018 Durham, England Air Transportation X 4000

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X 621

Curator University of Durham 6/8/2018 Per Diem X 410

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]
6/20/2018

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Gerald Fabris Audio Engineering Society 6/27/2018 Culpepper, VA Conference Fee X $595 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Museum Curator Audio Engineering Society 6/30/2018

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

State of Mississippi

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

caitlin_rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

National Park Service
Northeast Region

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available 
the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute 
a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  
(See  41 CFR §304-6.9).  

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) 
or the SF-326 (in PDF Format).

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a 
Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your 
workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the 
sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use 
the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_PWR_AprilSept2018.xls, for example 1353Report_OGE_OctMarch2011.xls.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of 
the workbook).

Filling in Page, Of Pages and  Year
Fill in the white-colored cells found below Page, Of Pages, and Year. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been 
protected so that you can tab between the fillable cells.

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you 
are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel 
Ribb   

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicating 1353 Travel

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-
keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

Indicating Reporting Period

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell 
below "Name."

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

Filling in Agency Name, Sub-Component Name, and Contact Information

You can select Print from the Print Preview view or Print as you traditionally would.

With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the 
option to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.



-
-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the 
print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education

Semiannual Report of Payment Accepted



Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission
Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission



James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President
Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation



Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED

    



DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC
EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC



JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP
OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC



PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov
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Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Christy Brigham Park Friends Alliance 
Meeting 10/9/2018 Glacier National Park, 

Montana Hotel X $402

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Air 
Transportation/Ca
r Rental

X $671

Chief of Resources 
Mgmt National Park Foundation 10/11/2018 10/09/18-10/12/18 Meals/Conference 

Registration X $364

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Christy Brigham OneTAM Science 
Conference 10/5/2018 Mill Valley, California Hotel X $184

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $80

Chief of Resources 
Mgmt

Golden Gate National 
Parks Conservancy 10/05/2018 10/04/18-10/05/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Christy Brigham
California Landscape 
Stewardship Network 
meeting

6/13/2018 Pacific Grove, 
California Hotel X $284

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $148

Chief of Resources 
Mgmt

Golden Gate National 
Parks Conservancy 06/15/2018 06/13/18-06/15/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Colleen Bathe Las Vegas Resort and 
Souvineer Show 9/25/2018 Las Vegas, Nevada Hotel X $424

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $172

Chief of Interpretation Las Vegas Resort and 
Souvineer Show 09/29/2018 09/24/18-09/29/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Colleen Bathe Park Partners Training 
Expo 7/16/2018 Tucson, Arizona Hotel X $426

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $354

Chief of Interpretation Western National Parks 
Association 07/20/2018 07/16/18-07/21/18 Registration X $200

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Colleen Bathe
Exhibit Plan Development 
via Sequoia Parks 
Conservancy

5/22/2018 San Francisco, 
California Hotel X $882

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Chief of Interpretation PWR Regional Office 05/24/2018 05/22/18-05/24/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Erika Williams
Exhibit Plan Development 
via Sequoia Parks 
Conservancy

5/22/2018 San Francisco, 
California Hotel X $882

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Visual Information 
Specialist PWR Regional Office 05/24/2018 05/22/18-05/24/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Jennifer Kirk Points of Light Conference 6/18/2018 Atlanta, Georgia Hotel X $800

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Air Transportation X $800

Volunteer Coordinator Service Unites, Points of 
Light 06/21/2018 06/17/18-06/21/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Emily Zivot Bystander Intervention 
Train-the-Trainer Course 9/11/2018 San Francisco, 

California Hotel X $834

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Park Ranger 
(Interpretation)

PWR of National Park 
Service 09/13/2018 09/10/18-09/13/18                            

Sequoia Parks 
Conservancy

Sequoia Parks 
Conservancy

OGE Form-1353
(OGE-Approved Alternative for SF-326)

February 2011

1353 Travel Report for National Park Serive, Pacific West Region for the reporting period APRIL 1 - SEPTEMBER 30, 2018

BENEFIT SOURCE

BENEFIT SOURCE

Sequoia Parks 
Conservancy

Golden Gate National 
Parks Conservancy

BENEFIT SOURCE

Asia Pacific Forum Pacific 
Rim Foundation 

BENEFIT SOURCE

BENEFIT SOURCE

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.
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TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

                           
TRAVELER NAME EVENT DESCRIPTION 09/11/2018                               

Thomas Arnold

NPS preservation of 
Wilderness Character 
Training

Seeley Lake, MT Airline Flight x $389.60

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging x $210.40

Park Guide WASO Wilderness 
Stewardsip 09/18/2018 9/9/2018 to 9/18/2018                            

TRAVELER NAME EVENT DESCRIPTION                               
Marti Witter SESYNC Workshop 9/17/2018 Annapolis, MD Airline Flight x $512.78

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Hotel X $405.00

Fire Ecologist SESYNC University MD 9/19/2018 9/17 to 9/19/2018 Ground Transp. X $140.00
Meals x $115.00

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Alison Forrestel Redwood Genome 
Workshop 6/11/2018 Eureka, CA Lodging X $258.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $88.50

Supervisory Vegetation 
Ecologist

Save the Redwoods 
League 6/13/18 6/11/18 to 6/13/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Michele Gee Lead Educator Workshop 6/26/2018 Honolulu, HI Airfare X $735.51

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging X $236.00

Ground Transp. X $150.00
Chief of Interpretation Japanese Cultural Center, 

Valor of the Pacific NJAHS 6/29/18 6/26/18 to 6/29/18 Meals X $380.00

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Kelli English
Training Session on new 
Cooperating Association 
Policies and Procedures

7/16/2018 Tucson, AZ Registration X $200

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Chief of Interpretation Western National Parks 
Association 7/20/18 7/16/18 to 7/20/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Amy Hoke University of Oregon 
Preservation Field School 9/9/2018 Portland, OR Lodging X $1,449.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Historical Landscape 
Architect

University of Oregon 
Preservation Field School 9/14/18 9/8/18 to 9/14/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Michelle Miki'ala 
Pescaia

Orientation Training for 
Interns of KALA 9/7/2018 Mokuleia, HI Airfare X $120.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Interpretive Park Ranger KUPU 9/7/18 9/7/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Alejandra Iraheta Buffalo Soldiers Lecture 7/19/2018 Monterey, CA Lodging X $298.16

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Interpretive Park Ranger Old Foundation of 
Monterey 07/19/18 7/19/18 to 7/20/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Dean Butterworth Facilitator training 9/12/2018 Leavenworth, WA Lodging x 75.35

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals x 35

Outreach & Ed Spec. Pacific Ed Institute 09/13/2018 9/12/18 & 9/13/18 Materials x 75

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Patricia Wold Conference/Training 10/22/2018 Tacoma,WA Registration x 450

TRAVELER TITLE EVENT SPONSOR Parking x 48
Interp Media Spec. Discover your NW 10/24/2018 10/22 & 10/24, 2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Christopher Roundtree Conference/Training 10/22/2018 Tacoma, WA Registration x 450

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Parking x 48

Visual Info Specialist Discover Your NW 10/24/2018 10/22 & 10/24, 2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Kristyn Loving Conference/Training 10/22/2018 Tacoma, WA Registration x 450

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Web & News Media Mgr Discover Your NW 10/24/2018 10/22 & 10/24, 2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

LOCATION

LOCATION

TRAVEL DATE(S)

TRAVEL DATE(S)

TRAVEL DATE(S)

LOCATION

LOCATION

BENEFIT SOURCE
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LOCATION

BENEFIT SOURCELOCATION

TRAVEL DATE(S)

Western National Parks 
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TRAVEL DATE(S)

LOCATION

LOCATION
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BENEFIT SOURCELOCATION
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TRAVEL DATE(S)

University of Oregon

National Japanese 
American Historical 

BENEFIT SOURCE

LOCATION

TRAVEL DATE(S)
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SESYNC Project Fund

BENEFIT SOURCE

KUPU

BENEFIT SOURCE

BENEFIT SOURCE

Save the Redwoods 
League

BENEFIT SOURCE

Old Monterey Foundation

Western Museum Assoc

Western Museum Assoc

BENEFIT SOURCE

BENEFIT SOURCE

Western Museum Assoc

BENEFIT SOURCE

WA Grain Commission
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BENEFIT SOURCE
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LOCATION

LOCATION

LOCATION
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Jenkins Palmer Board meeting 6/15/2018 Mt. Rainier Meal x 30

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Superintendent WA National Park Fund 06/16/2018 None                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Jodi Bailey Technical Assistance 1/27/2018 Santiago, Chile Air Fare x 5700

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging x 2812

Program Manager 
International Affairs CONAF 02/10/2019 04/18/2018 Meals x 1436

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Shelton Johnson
Participation in Public 
Panel 5/1/2018 New York, New York Air Fare x 550

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging x 1300

Interpretive Park Ranger Public Broadcasting 04/30/2018 04/30/2018 to 
05/03/2018 Theater Tickets x 194

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Ackerman, Craig NPS Superintendent's 
Leadership Roundtable #9 4/23/2018 Chico Hot Springs, 

MT Airfare X $393.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

CRLA Superintendent NPS  04/27/2018 04/23/2018 & 
04/27/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Forbes, Sheri

"Parks and Partners 2018" 
- Training in cooperating 
association partnerships 
best practices, RM-32, and 
Program Management

7/16/2018 Tucson, AZ Registration X $200.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

Regional Program Lead, 
I&E

NPS & Western National 
Parks Association 07/20/2018 07/16/2018 & 

07/20/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Low, Jared WNPF Spring Dinner & 
Auction 4/7/2018 Seattle, WA Lodging X $175.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $50.00

Park Ranger (I) WNPF 04/07/2018 04/07/2018 & 
04/08/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Orlando, Cindy Preservation Honor 
Awards Ceremony 5/23/2018 Honolulu, HI Registration X $50.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             

HAVO Superintendent Historic Hawaii Foundation 05/23/2018 05/23/2018 & 
05/23/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              

Taylor-Goodrich, Karen

Washington's National 
Park Fund (WNPF) 
Meeting/Annual Board of 
Directors Retreat

6/15/2018 Longmire, WA Lodging X $200.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Meals X $50.00

NOCA Superintendent WNPF 06/16/2018 06/15/2018 & 
06/16/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

BENEFIT SOURCE

BENEFIT SOURCE

LOCATION

TRAVEL DATE(S)

BENEFIT SOURCELOCATION

TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)

LOCATION
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TRAVEL DATE(S)

TRAVEL DATE(S)

BENEFIT SOURCE

CONAF Chile National 
Park Service

TRAVEL DATE(S)

TRAVEL DATE(S)

LOCATION BENEFIT SOURCE
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BENEFIT SOURCE

Western National Parks 
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TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)
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TRAVEL DATE(S)
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TRAVEL DATE(S)

LOCATION
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LOCATION BENEFIT SOURCE
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LOCATION
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BENEFIT SOURCE

Hawaii Pacific Parks 
Association

WNPF

BENEFIT SOURCE

Crater Lake Natural 
History Association
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The Public Theater, 
American Prairie Reserve
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WA National Park Fund

LOCATION

TRAVEL DATE(S)

LOCATION BENEFIT SOURCE
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TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

                              
                              0

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                             
                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]
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TRAVELER TITLE EVENT SPONSOR ENDING DATE 
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[MM/DD/YYYY]
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                              0
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[MM/DD/YYYY]
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[MM/DD/YYYY]

                              
                              0
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Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov
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Agency Contact: Caitlin Rogalski

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Janet Folkerts Open house for Vets 9/27/2018 New York NY Train 
Transportation X $162 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $216.30 

Museum Curator Bard Graduate Center 27-Sep 9/27/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Carlos del la Torre Workshop on Community 
Engagement 4/15/2018 Jackson WY Hotel X $275 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $125 

Park Guide Groundworks USA 20-Apr 4/15-4/20                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Carlos del la Torre Workshop on Community 
Engagement 4/15/2018 Jackson WY Air Transportation X $834 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Park Guide Groundworks USA 20-Apr 4/15-4/20                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

DOI, NPS, NCR, WASO, NER, SER
National Park Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

caitlin_rogalski@nps.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Bard Graduate Center

BENEFIT SOURCE

Grand Teton Nat'l Park 
Foundation

BENEFIT SOURCE

Groundworks USA

BENEFIT SOURCE
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